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Introduction

XMTR-MV simulates a generic Multi-Variable HART 5, 6 or 7 slave field device.
XMTR-MV’s principle objectives are:

1. Support Physical Layer testing

2. Verify HART 5 master compatibility with HART 5, 6 and 7 field devices.

3. Verify HART 6 master compatibility with HART 5, 6 and 7 field devices.

4. Verify HART 7 master compatibility with HART 5, 6 and 7 field devices.

All Xmtr-MV command responses comply with HART 7 requirements including the longer Identity
Command (commands 0, 11, 21, 72) responses. The additional data includes the Response
Preambles (1 byte); the number of Device Variables (1 byte); and the Configuration Count (two
bytes). The Configuration Count is a non-valatile counter indicating the number of times the Xmtr-
MV configuration has changed.

In addition, this tool supports HART master development and many will find XMTR-MV an
educational demonstration of several HART features.
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1. SYSTEM REQUIREMENTS

Although it is a small Windows application, XMTR benefits from processors running at 1GHz or
greater, RAM of 1GB or more, and access to the processor without waiting or interruption. The
timing requirements of HART dictate the resource consumption by XMTR. A registered HART
modem via RS232 or virtual serial port is also required.

Sometimes operating systems and applications do not release resources in a timely enough manner
for XMTR to respond within expected time. It is possible to run XMTR and other applications on
systems with sufficient processor and memory.

2. NETWORK SETUP

System performance and results are improved and reliability increased when running XMTR-MV on
a proper HART network using modems, device, power supply, and resistor for modem connection.
A simple system of null-modem connections between XMTR and the test system (even on the same
machine) can be accomplished with sufficient memory and processor speeds.

3. INI FILE
XMTR-MV uses an INI file (installed in the WINNT/WINDOWS folder). The file contains important
information that establishes the identity of the XMTR-MV device.

3.1 KEYS

3.1.1 [Device]
The file must begin with the keyword device.

MfriD=249
The Manufacturer ID for XMTR-MV is the HART Communication Foundation expansion

DevTyplD=63874
The Device Type must be set to HART 7 Expanded devices type.

UnivRev=7
Universal Revision determines whether the device will function as a HART 5, 6 or 7 device. The
default is revision 7 device.

DevRev=1
Device Revision is 1.

SignalCode=0
Physical Signaling Code.
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DeviceFlags=1
Device flag indicates that this device is a multi-sensor field device. This is the only option at this
time.

ConfigCount=0
Configuration counter, increments each time changes are applied to XMTR-MV.

Delay=10
Determines the Delayed Response time in seconds. This should be adjusted depending on the
speed of the machine used to run the application. Faster machines may decrease this value.

Devlock=-1
Device supports lock, but it is disabled by default.

3.1.2 [App]

ComPort=42
0 based comport identification. Can be selected from the menu.

4, OPERATING GUIDE

4.1 File menu commands
The File menu offers the following commands:

Default Creates a new document with XMTR-MV default parameters.
Open Opens an existing XMTR-MV document.

Save Saves an opened document using the same file name.

Save As Saves an opened document to a specified file name.

Exit Exits XMTR-MV

1, 2, 3, 4 command

Use the numbers and filenames listed at the bottom of the File menu to open the last four
documents you closed. Choose the number that corresponds with the document you want to
open.

Default command
Shortcut Keys: CTRL+N

Use this command to create a document with default XMTR-MV settings. The filename will be
"Untitled" until you save these parameters to disk. To save a document use the Save or Save As.
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You can open an existing document with the Open.

Exit command
Shortcut Keys: ALT+F4

Use this command to end your XMTR-MV session. You can also use the Close command on the
application Control menu. XMTR-MV prompts you to save documents with unsaved changes.

Open command
Shortcut Keys: CTRL+O

Use this command to open a previously saved XMTR-MV document. You can create new document
with default settings with the Default command.

Save As command
Use this command to save and name the active document. XMTR-MV displays the Save As dialog
box. To save a document with its existing name and directory, use the Save.

Save command
Shortcut Keys: CTRL+S

Use this command to save the active document to its current name and directory. When you save
a document for the first time, XMTR-MV displays the Save As dialog box so you can name your
document. If you want to change the name and directory of an existing document before you
save it, choose the Save As command.

Note: This command will not be available unless you press the Apply button.

Active Configuration
This displays the currently open configuration document file. A check mark appears in front of the
document name.

Untitled

The filename "Untitled" indicates that the "default" parameters are in place and that these
parameters have not been saved to disk. Selecting the Default Command will reset the XMTR-MV
parameters to the "default" parameters.

4.2 Edit menu commands
The Edit menu offers the following commands:

Undo Reverse previous editing operation.
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Cut Deletes data from the document and moves it to the clipboard.
Copy Copies data from the document to the clipboard.

Paste Pastes data from the clipboard into the document.

Copy command

Shortcut Keys: CTRL+C

Use this command to copy selected data onto the clipboard. This command is unavailable if there
is no data currently selected. Copying data to the clipboard replaces the contents previously stored
there.

Cut command
Shortcut Keys: CTRL+X

Use this command to remove the currently selected data from the document and put it on the
clipboard. This command is unavailable if there is no data currently selected. Cutting data to the
clipboard replaces the contents previously stored there.

Undo command
Shortcut Keys: CTRL+Z or ALT-BACKSPACE

Use this command to reverse the last editing action, if possible. The Undo command is non-
functioning (disabled) on the menu if you cannot reverse your last action.

Paste command
Shortcut Keys: CTRL+V

Use this command to insert a copy of the clipboard contents at the insertion point. This command
is unavailable if the clipboard is empty.

Apply button
Shortcut Keys: CTRL+A

The Apply button (when pressed) modifies the data in your document and allows the data on the
display window to be seen by a HART master. You must use the Save command if you want to
permanently store the HART parameters to disk.

In addition, every time that this button is pressed, the Configuration Change Counter on the Device
Display increases by one.
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The Apply button is non-functioning (disabled) when no changes have been made to the document.
If you make an error you can use the Undo command to reverse the change for that particular item
or press the_Cancel button to undo all changes made to the page.

Cancel button
Shortcut Keys: CTRL+Q

The Cancel button completely restores all data that is in the document to the display window. It is
similar to the Undo command , except that it performs an undo on all changes made to the page.

4.3 Title Bar

The title bar is located along the top of a window. It contains the name of the HART tag and long
tag separated by a comma, followed by the type of device. In this case, the application simulates a
XMTR-MV device.

To move the window, drag the title bar. Note: You can also move dialog boxes by dragging their
title bars.

4.4 View menu commands
The View menu offers the following commands:

Toolbar Shows or hides the toolbar.

Status Bar Shows or hides the status bar.

Toolbar command

Use this command to display and hide the Toolbar, which includes buttons for some of the most
common commands in XMTR-MV, such as File Open. A check mark appears next to the menu item
when the Toolbar is displayed.

Status Bar command

Use this command to display and hide the Status Bar, which describes the action to be executed by
the selected menu item or depressed toolbar button, and keyboard latch state. A check mark
appears next to the menu item when the Status Bar is displayed.

The status bar is displayed at the bottom of the XMTR-MV window. To display or hide the status
bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to
navigate through menus. This area similarly shows messages that describe the actions of toolbar
buttons as you depress them, before releasing them. If after viewing the description of the toolbar
button command you wish not to execute the command, then release the mouse button while the
pointer is off the toolbar button.
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The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description

RC The Response Code from the field device on HART message.

DS The Device Status code from the field device on HART message.

CS The Communication Status code from the field device on HART message (if any)

Panel Lock The Lock Mode feature is "On".

CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.
4.5 Help menu commands

The Help menu offers the following commands, which provide you assistance with this application:

Help Offers you an index to topics on which you can get help.
TopicsHID_HELP_IN
DEX

AboutHID APP_ABO Displays the version number of this application.
uT

45.1 Context Help command
Shortcut Keys: SHIFT+F1

Use the Context Help command to obtain help on some portion of XMTR-MV. When you choose
the Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.
Then click somewhere in the XMTR-MV window, such as another Toolbar button. The Help topic
will be shown for the item you clicked

4.5.2 About command
Use this command to display the copyright notice and version number of your copy of XMTR-MV
application.

It also give a description on the purpose of the application as well as the telephone numbers for
technical support.

4.6 Settings menu commands
The Settings menu offers the following commands:
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Panel Shows device panel sub menu
Ports Displays serial port communication settings window
4.6.1 Device Panel menu

The Device Panel menu offers the following commands:

Squawk Executes the sounding mechanism of the device
Self Test Executes Self Test
UnLock Executes mechanism to unlock the device

Unlock Panel command (Settings\Device Panel menu)
Use this command to unlock the Display windows of the XMTR-MV device. This menu command
allows the user to changed the HART parameters in each of the Display windows.

Self Test command (Settings\Device Panel menu)
Use this command to activate the Self Test feature of the XMTR-MV device. This is equivalent to
executing HART command 41.

Squawk command (Settings\Device Panel menu)
Use this command to activate the Squawk feature of the XMTR-MV device. This is equivalent to
executing HART command 72.

4.6.2 Communications Port
Use this menu option to open the Communication Port window to choose the correct serial port for
HART communication.
Select
1 - coOmMm1
2 - COM2
Etc.

Enter the number directly or use the up and down arrows for the appropriate choice. The
application can only use one serial port at a time.

4.7 Connection Log Display
The display window shows all the message traffic to and from the XMTR-MV device. Only HART
messages which are addressed to this device are displayed on this window.

Clear the connection log press CTRL+D
Pause Connection Log press CTRL+P
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The pause button will allow for a fixed line on the Connection Log Display window to be
maintained. The vertical scroll bar can be manually adjusted when this feature is activated.

My XMTR , Xmir Simulator - Generic MultiVariable = | (G
File Edit Settings View Help
~
D|=@| &[5[2[x] 2[u] x|
E Device Varable 0 ] Device Varable 1 ] Device Varable 2 ] Device Vanable 3 ] Cptions ] I:l
] Connection Log l Status ] More Status ] HART ] Revision ] Device ] Dynamic Varables ] Temperature ]
Del Mstr Bur 2ddress CMD BC Status Data
Hex Dec Dec Hex Hex
§
|
For Help, press F1 RC 00 |DS 0x40

4.7.1.1 Log Column Title:

Del (Delimiter)
(start character) - Identifies the source of the message and whether the field device is in burst
mode. Master to slave (STX), slave to master (ACK), or burst mode from slave (BACK).

Mstr (Master)
Identifies the type of master. Primary master (PRI) or secondary master (SEC).

Bur (Burst)
Indicates whether the slave is in burst mode. Burst mode on (ON) or burst mode off (- -).

Address

Five bytes indicating the manufacturer ID, device type, and device ID. The values are in
hexadecimal and are displayed in three groups. The first group shows two digits, representing the
manufacturer ID ( 6 least significant bits). The next group shows a two digit value of the device
type. The last group shows 6 digits (three bytes) representing the device ID. (For more specifics
see HART Displa
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CMD
Command - The HART command ranging from 0 to 9999 in decimal.

Note: For command expansion (Command # 31), the number 31 will not appear in this field unless
the Byte Count sent from a Host device is less than two (response code = 5). There must be at least
two data bytes to determine Device Family command number..

BC (Byte Count)
The number of bytes (decimal 0 to 256) remaining in the message. It includes the two status and
the data bytes.

Status

Two byte (bit-coded information) in hexadecimal in the reply message from a slave. The first byte
includes communication errors, if any. If no communication errors, this byte indicates the response
code for a particular HART command. The second byte indicates the operational state of the field
device. The specifics of the status bytes are shown in Status Display.

Data
Displays the data bytes of the message in hexadecimal.

Note: For command expansion, Command # 31, the first two data bytes are reserved for the
Device Family command number. However, these two data bytes will not show in the Data field
even thought the Byte count accounts for them.

4.8 Console
The console is the main window of the XMTR-MV application.
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My XMTR , Xmtr Simulator - Generic MultiVariable (=[E] % |
File Edit Settings View Help
D|E| [=|al 2[n] W
Device Varable 0 I Device Varable 1 ] Device Varable 2 ] Device Varable 3 ] Options ]
Connection Log ] Status ] More Status ] HART I Revision ] Device Dynamic Variables l Temperature ]
Process
PV SV T av
Dev War No. 0 1 2 3
Value 50.80 1460 3240 126.40
Units Code mm Hg - T - ppth - nml m3 -
Status 0o (Hex) | |00 0o 0o
Sensor Upper Limit 1000.00
Sensor Lower Limt | |0.00
Minimum Span 20.00
Damping 0.00
Sensor Serial No. 7654
Range Loop Current
Units Code mm Hg % Range |50.80 Analog Value [12.128
Upper Range Value 100.00 Alam Code High -
Lower Range Value  |0.00 Transfer Function | Linear - Loop Mode |Enabled v
For Help, press F1 RC 00 |DS0:20

There are 13 different display windows as shown above.

All data associated with this device are

shown in these windows. The values in these windows can be modified to give different values to a
master. However, when the Lock Mode is "on", the display windows are configured to be read-
only cannot be modified. If you make a change on any window, you will be asked to save or cancel
those changes before proceeding to another display window.

4.9
Click - To

Controls

Apply - Make the data immediately available to a HART master

Cancel - Undo all changes made on the page

4.10 Changed Data Window

If you make changes to a Display window and select the tab of another window without pressing
the Apply or Cancel button, you will get the Changed Data message window. Selecting the "Yes"

button is equivalent to selecting the Apply button, whereas "No" is identical to selecting the Cancel
button.

4.11 Device Display

The display window shows information pertaining to device specifics of the slave.
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Physical Signaling Code
This parameter identifies a particular hardware configuration of the slave. It takes on the following
enumerated values:

0 - Bell 202 current

1 - Bell 202 voltage

2 -RS 485
3 -RS 232
6 - Special

This code is in hexadecimal (read-only) and cannot be changed from the user interface (changes
must edited in the ini file).

Device Flags
This parameter identifies a particular hardware configuration of the slave. It takes on the following
enumerated values:

1 - Multisens dev
2 - EEPROM ctrl
4 - Protocol bridge device

This code is in hexadecimal (read-only) and cannot be changed from the user interface (changes
must be edited in the ini file).

Message

This parameter identifies the "message" string in the field device. The string is read with Command
12 and written to the device with Command 17. The value is a 32 character string and it is
transmitted in Packed ASCII using 24 bytes. This string can be modified.

Descriptor

This parameter identifies the "descriptor" string in the field device. The string is read with
Command 13 and written to the device with Command 18. The value is a 16 character string and it
is transmitted in Packed ASCIl using 12 bytes. This string can be modified.

Date
Identifies the Day, Month and Year in three data fields
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Day - The left parameter identifies the day of the month. This value can be modified to take on any
positive integer between 1 and 31. (Note: Some months do not have a 29th, 30th or 31st day. This
application does not conduct error checking for this situation)

Month - The middle parameter identifies the month of the year. This value can be modified to take
on any positive integer between 1 and 12

Year - The right parameter identifies the month of the year. This value can be modified to take on
any positive integer between 1900 and 2155.

Write Protect
This parameter identifies whether the device is in write protect mode.

Yes - Indicates that that the device is "write protected" and most of the commands that change
information within the device will not be executed. The Self Test, Master Reset, and all read
commands will operate normally in this mode. Those commands not executed for this reason will
return Command-Specific Response Code #7,

No - Indicates that that the device is NOT "write protected" and the device will operate as normal.
(Other selections, Refer to Common Table 7)

Final Assembly Number

This parameter identifies the three byte final assembly number. This value is read with Command
16 and written to the device with Command 19. This value can be modified to take on any
hexadecimal value between 0x000000 to OxFFFFFF.

Private Label Distributor

The Private Label Distributor Code provides the ability for one manufacturer to sell devices
manufactured by another manufacturer without the name of the primary manufacturer appearing.
The Private Label Distributor Code is returned with Command #15. This value can be modified to
take on any hexadecimal value between 0x00 to OxFF.

No. of Device Variables
Number of variables in the field device that is associated with process information. The value
changes as the process it connects to varies.

Read with

Command 0 (Read Unique Identifier)

Config Change Count

Tracks the number of times the configuration in the field device has changed. This count increases
every time there is a "Write" command from a master or when the Apply button is pressed by the
user.
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Device Variables (0 to 3) Display

The display window shows information pertaining to a uniquely defined data item within a field
device. Each Device Variable represents a direct or indirect connection between the process and
the field device. All HART compatible field devices contain Device Variables. Simple field devices
may use only Dynamic Variables. However, this application does expose the underlying Device
Variables at the Application Layer.

Device Family Code
This string name represents the enumeration code of the family that this device variable belongs to
(see HART Common Table 19 - Device Family Codes).

Read with command 54 (Read Device Variable Information)

Value

Digital value that changes magnitude with respect to a monitoring process over time. This window
shows a digital representation of the Device Variable value. This value is a floating point number
and can be modified.

Note: Since there is no actual process being monitored, the application never changes this value.

Read with Command 33 (Read Device Variables)

Units Code

This is an enumeration list of strings representing an engineering unit (one byte value - 0 to 255 ) to
be displayed with the Digital Value representation, Minimum Span, Lower Sensor Limit and Upper
Sensor Limit for this device variable (see Common Table 2. Unit Codes). This value can be modified
by selecting the new units name in the display window.

Read with Command 33 (Read Device Variables) or Command 54 (Read Device Variable
Information).

Status

This value corresponds to a one byte value that contains additional data quality information
associated with each process connection. This value can be modified to take on any hexadecimal
value between 0x00 to OxFF.

Read with Command 33 (Read Device Variables)

Sensor Upper Limit
Defines the maximum usable value for the sensor value. This value is a floating point number and
can be modified.

Read with Command 54 (Read Device Variable Information).
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Sensor Lower Limit
Defines the minimum usable value for the sensor value. This value is a floating point number and
can be modified.

Read with Command 54 (Read Device Variable Information).

Minimum Span

Defines the smallest allowable difference between the sensor's Upper and Lower Range Values if
this device variable is ever mapped to PV. This value is a floating point number and can be
modified.

Read with Command 54 (Read Device Variable Information).

Damping
Damping time constant applied to the sensor's Digital Value representation. The units of this
variable are always in seconds. This value is a floating point number and can be modified.

Read with Command 54 (Read Device Variable Information).

Written with Command 55 (Write Device Variable Damping Value)

Sensor Serial No.
Uniquely identifies the sensor.

Read with Command 54 (Read Device Variable Information).

Device Family Commands Supported
Yes - Device Family Commands are implemented for this device variable.

No - Device Family Commands are not implemented for this device variable.

Read with Command 54 (Read Device Variable Information).

4.12 Dynamic Variables Display
The display window shows information pertaining to the connection between the process and an
analog channel in a field device.

PV, SV, TV, Qv

Dynamic Variables are collectively those device variables that are mapped to the Primary (PV),
Secondary (SV), Tertiary (TV), and Quaternary (QV) Variables. Each of these variables are then
mapped to the first 4 analog channels in the field device. The Primary Variable is connected to the
first 4-20 mA channel, the same channel that always supports HART communication. In the XMTR-
MV application there is only one analog channel and it is associated with PV.
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Dev Var No.

This value identifies the mapped relationship between the Device Variable and the Dynamic
Variable. This value is a positive integer (0 to 255) (read-only) and can not be changed. Although a
field device can have many Device Variables, there can only be a maximum of four Dynamic
Variables per device.

Read with Command 50 (Read Dynamic Variable Assignments)

Value

Digital value that changes magnitude with respect to a monitoring process over time. This window
shows a digital representation of the PV,SV,TV or QV values. This value is a floating point number
and can be modified.

Note: Since there is no actual process being monitored, the application never changes this value.

Read with Command 1 (Read Primary Variable) - PV only or Command 3 (Read Current and Four
Dynamic Variables)

Units Code

This is an enumeration list of strings representing an engineering unit (one byte value - 0 to 255 ) to
be displayed with the Digital Value representation, Minimum Span, Upper Range Value, Lower
Range Value, Lower Sensor Limit, and Upper Sensor Limit. There is a unique list associated with
each Device Family. (For more information, see Common Table 2. Unit Codes). This value can be
modified by selecting a new units name in the display window.

Read with:
Command 1 (Read Primary Variable) - PV only
Command 3 (Read Current and Four Dynamic Variables)
Command 14 (Read Primary Variable Sensor Information) - PV only

Command 54 (Read Device Variable Information)

Written with:
Command 44 (Write Primary Variable Units) - PV only
Command 53 (Write Device Variable Units)

Status

This value corresponds to a one byte value that contains additional data quality information
associated with each process connection. This value can be modified to take on any hexadecimal
value between 0x00 to OxFF.

Read with:
Command 1 (Read Primary Variable)
Command 2 (Read Current and Percent of Range)

Command 3 (Read Current and Four Dynamic Variables)
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Sensor Information (PV only)
Sensor Upper Limit

Defines the maximum usable value for the PV Upper Range Value. This value is a floating point
number and can be modified.

Sensor Lower Limit
Defines the minimum usable value for the PV Lower Range Value. This value is a floating point
number and can be modified.

Minimum Span
Defines the smallest allowable difference between the PV Upper and Lower Range Values This
value is a floating point number and can be modified.

Damping

Damping time constant applied to both the PV Digital Value representation and Analog Value of the
respective Analog Output. The units of this variable are always in seconds. This value is a floating
point number and can be modified.

Sensor Serial No.
Uniquely identifies the sensor from which the PV Digital Value is primarily derived.

Read with (All Sensor Information):
Command 14 (Read Primary Variable Sensor Information)
Command 54 (Read Device Variable Information).

Written with (Damping only):
Command 34 (Write Damping Value)

Range Units Code
Engineering unit of the Analog Value. This value repeats the PV Units Code shown above and can
not be changed (read-only)

Upper Range Value

Defines the operational endpoint from which the Analog Value, and the 100% point of the Percent
Range are derived. In addition, the Upper Range Value defines an operational endpoint which the
alarms associated with the Analog Value,

Lower Range Value

Defines the operational endpoint from which the Analog Value, and the 0% point of the Percent
Range are derived. In addition, the Lower Range Value defines an operational endpoint which the
alarms associated with the Analog Value, and the alarms associated with the Digital Value
representation are derived."
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% Range

Variable that tracks the Digital Value representation with respect to the range defined by the Lower
Range Value and Upper Range Value. The application automatically calculates this value by
comparing the PV Digital Value to its Upper and Lower range values and can not be changed (read-
only). The units of this variable are always in percent

Transfer Function

Defines the transformation function that will be applied from the Field Device Variable to the
Analog Output, and Percent Range. The Transfer Function does not affect the Digital Value
representation.

Loop Current Analog Value

Value that tracks the PV Digital Value representation, under normal operating modes. The
application automatically calculates this value by comparing the PV Digital Value to its Upper and
Lower range values and can not be changed modified directly (read-only).. In Fixed Current Mode
(Bit #3 - Analog output #1 fixed is set), the analog value is constant and does not follow the PV
Value.

Alarm code

This is an enumeration list of strings defining how the Analog Output will respond when the Field
Device detects that the Analog Output may not be tracking the PV Digital Value. During a Field
device malfunction., if this selection is set to "High", then the analog output will be held at a
constant value of 23 mA. Likewise, If this selection is set to "Low", then the analog output will be
held at a constant value of 3.8 mA. All other selections, will cause the analog output to track the
PV as normal.

4.13 HART Display

The display window shows information pertaining to the HART communication parameters.

Identification

This information helps the master to correctly identify each field device. Changing these
parameters will cause the master to view the slave as a different device. These parameters are
displayed in the address field on the Connection Log Display.

Manufacturer Identification
This parameter identifies the correct manufacturer of the field device. This value is in hexadecimal
(read-only) and can not be changed.

Device Type
This parameter identifies the correct device type of the field device. This value is in hexadecimal
(read-only) and can not be changed.
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Device Identification
This parameter identifies the correct device identifier of the field device. This value can be
modified to take on any hexadecimal value between 0x000000 to OxFFFFFF.

Polling Address

This parameter identifies the correct polling address used in short frame Command 0. This value
can be modified to take on any positive integer between 0 to 15. In Multi-drop (address does not
equal zero), the device is placed in Fixed Current Mode

(Bit #3 - Analog output #1 fixed is set) and the Analog Value is parked at 4 mA.

Preambles Request
This parameter identifies the number of preambles that the field device desires the master to send
to the device. This value can be modified to take on any positive integer between 3 and 255.

Response

This parameter identifies the number of preambles that the field device will send back to the
master in reply messages. This value can be modified to take on any positive integer between 3
and 255.

Tag

This parameter identifies the short tag name of the field device it is used to identify the device in
Command 11. The value is an 8 character string and it is transmitted in Packed ASCII using 6 bytes.
This string can be modified.

Long Tag

This parameter identifies the long tag name of the field device. It is used to identify the device in
Command 21. The value is a 32 character string and it is transmitted in ASCIl using 32 bytes. This
string can be modified.

4.14 Dynamic Variable Mapping

Xmtr-MV supports 4 Device Variables randomly mapped to the Dynamic Variables: PV is mapped to
Device Variable 1; SV Device Variable 0; TV to Device Variable 2; and QV to Device Variable 3. This
mapping can be read using Command 50. In addition, this mapping is shown in the Dynamic
Variable window.

Device Variable Classification

Each Device Variable in Xmtr-MV belongs to a different Device Family. HART 6 adds two additional
bytes to Command 54 (Read Device Variable Information). The first indicates the Device Family
and the second whether the Device Variable supports the Device Family Commands. These two
values are shown in the respective Device VariableDevice_Variables window.
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Device Family Commands

Xmtr-MV supports the Temperature Device Family Commands. All mandatory & most optional
Temperature Device Family commands are supported. Properties like Probe Type, Number of
Wires, Probe Connection, Cold Junction Compensation (CJC), Manual CIC Temperature, and Manual
CJC Temperature Units, are shown on the Temperature Display window.

Unit Code Expansion

Xmtr-MV demonstrates HART 6 Unit Code Expansion using a fictional Gas Concentration Family. In
HART 6 the definition of Unit Codes 170-229 are based on the Device Family type. The Unit Codes
available for Gas Concentration are shown on the Device Variable 1 window. The Unit Codes
supported include those specified in HART 5 such as 8 (millibar), 11 (Pascals), 12 (kiloPascals) and
139 (ppm) as well as Device Family specific Unit Codes like: 170 (ppb), 171 (percent volume), 172
(volume per million); 173 (volume per billion); ... ; 185 (percent lower explosive limit).

Process Data Quality

Xmtr-MV returns an additional status byte for each Dynamic Variable in Commands 1, 2, 3 and for
each Device Variable in Command 33. This value is shown as "Status" in the Dynamic Variable and
DeviceDevice_Variables windows.

4.15 More Status Display

The display window shows 25 bytes of data information associated with Command 48 (Read
Additional Transmitter Status).This display shows the Transmitter Status information not included
in the response codes. These values are manually manipulated and the application will not change
them.

Data Bytes

There are 17 bytes values which are associated with Transmitter-Specific Status (Status Byte 0-5 &
6 - 16) bytes and 2 bytes for the Opererating Mode (Oper Bytes 1 & 2). These values can be
modified to take on any hexadecimal value between 0x00 to OxFF.

The remaining 6 bytes are handled by the Analog Output Saturated (A/O Sat) and Analog Output
Fixed (A/O Fixed) parameters. Both of these parameters are three bytes in length and can be
modified to take on any hexadecimal value between 0x000000 to OxFFFFFF.

Truncation

HART 6 requires Command 48 to return at least 14 bytes (A/O Fixed). XMTR-MV allows Command
48 to be truncated at any point after the 14th byte as desired for master testing. If desired,
selection of "Do Not Truncate" is also possible.

Do Not Truncate
Check this box, if all 25 bytes of Command 48 need to be sent to a Master.
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Truncate after:
This list contains the number of possible positions where Command 48 can be truncated. The
default positon is after A/O Fixed.

4.16 Revision Display
The display window shows information pertaining to the the field device revision information.

Universal Revision
This parameter identifies the correct HART revision level of the field device. This value is in decimal
(read-only) and cannot be changed.

Device Revision

This parameter identifies the device revision (Dev Rev) level of the field device. This parameter
helps the master determine what commands the field device supports. This value is in decimal
(read-only) and cannot be changed.

Software Revision
This parameter identifies the number of times the firmware has been modified. This value is in
decimal (read-only) and cannot be changed.

Hardware Revision
This parameter identifies the number of times the hardware has been modified. This value is in
decimal (read-only) and cannot be changed.

4.17 Status Display

The display window shows bit-coded information of the two status bytes of the reply message from
the slave to the master. The bits for the device status and communication status can be toggle
"on" and "off"

4.17.1 1st Status Byte

Comm Status - (Bit7=1)

Bits 1 and 3 through 6 are for simulated purposes only and do not actually represent a
communication problem. By toggling any of these bits "on" (selection has check mark), the
application will automatically cause Comm Status Bit # 7 to turn "on" and will disable all the device
status bits (selections will be grayed out). Although there may be some check marks in the device
status bits, none of these states will be active to a HART master. The 2nd byte will only contains
zeros during communication errors. Once you turn off the communication error, all the device
status bits will be restored to their previous states. The communication error can be turned off by
either removing the check mark on Comm Status Bit # 7 or by individually turning "off" all the
Comm Status Bits (1 and 3 through 6)

Revision 1.0, Release Date: 22 March, 2010 Page 25 of 29



HART Communication Foundation Document Number: HCF_LIT-069
Document Title: XMTR-MV User Manual

Response Code - (Bit 7 = 0)
The response byte value for each command returned by the field device will be displayed here in
decimal along with text displaying the response string.

4.17.2 2nd Status Byte - Device Status

Bit 0 - Primary variable out of limits
This flag is set (check mark) when the PV Value is greater than the Sensor Upper Limit or less than
the Sensor Lower Limit.

Bit 1 - Non-Primary variable out of limits
This flag is set (check mark) when the SV, TV or QV Value is greater than the Sensor Upper Limit or
less than the Sensor Lower Limit.

Bit 2 - Analog output #1 saturated
This flag is set (check mark) whenever the analog value is above 20.8 milliamperes or below 3.9
milliamperes.

Note: During field device malfunction (Device Status Bit #7 is set), this flag is always "off" and the
check box is disabled (read only).

Bit 3 - Analog output #1 fixed

This flag is set (check mark) either when a Command 40 (Fixed Current Mode) is sent from a
master, the device is in Multi-drop mode or when clicking the check box. In Fixed Current Mode,
the analog value remains constant and will not follow the PV Value.

Note: In Multi-drop mode, this flag is always "on" (check mark) and during a Field Device
Malfunction (Device Status Bit #7 is set), this flag is always "off". In both cases this check box is
disabled (read only) and can not be modified.

Bit 4 - More status available
This flag is only set (check mark) when it is manually selected. The application will not change it.

Bit 5 - Cold start
This flag is only set (check mark) when it is manually selected. The application will not change it.

Bit 6 - Configuration changed
This flag is set (check mark) when either a WRITE command is issued to the device, when the Apply
button is pressed or when when it is manually selected.

Note: changing the status bits and selecting the Apply button does not change the configuration of
the device, therefore this flag won't be set

Revision 1.0, Release Date: 22 March, 2010 Page 26 of 29



HART Communication Foundation Document Number: HCF_LIT-069
Document Title: XMTR-MV User Manual

Bit 7 - Field device malfunction

This flag is set (check mark) only when it is manually selected. The application will not change it.
When this flag is set, the analog value will behave according to the Alarm Code and may not follow
the PV Value.

4.18 Temperature Display
The display window shows information pertaining to the temperature device family commands of
the field device.

Probe Type

This is an enumeration list of strings representing the sensor technology used to measure
temperature. This technology includes thermocouples, RTDs (resistance measurement) and
thermistors. (For more information, see Common Table 16. Temperature Probe Definitions). This
value can be modified by selecting the a new probe type name in the display window.

Read with Command 1024 (Read Temperature Probe)

Written with Command 1027 (Write Temperature Probe Type)

Number of Wires

This is a list of the number of possible wires for a particular probe type. Thermocouples always
have 2 wire, so when the the probe type begins with TC, this selection will only accept the value of
2 and cannot be modified..

Read with Command 1024 (Read Temperature Probe)

Written with_.Command 1027 (Write Temperature Probe Type)

Probe Connection

This is an enumeration list of strings representing the possible types of thermocouple connections.
"Single" implies one thermocouple where as "Differential" denotes that two thermocouples are
connected together. This selection only applies if the Probe Type is a thermocouple. When the
Probe Type is not a thermocouple, this list will be disabled (grayed out) and can not be selected.

Read with Command 1025 (Read Thermocouple Configuration)

Written with Command 1029 (Write Temperature Probe Connect)

Cold Junction Compensation

This selection only applies if the Probe Type is a thermocouple. This selection indicates whether
the temperature compensation is "Built-in", "External”, "Fixed", etc. If the compensation is "Fixed"
(manual), then values for the manual CJC temperature and units will need to be selected.

Read with Command 1025 (Read Thermocouple Configuration)
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Written with.Command 1030 (Write Temperature Cold Junction Compensation Type)

Manual CJC Temperature
This selection only applies if the Probe Type is a thermocouple and the Cold Junction Compensation
is "Fixed". Enter the appropriate temperature value of the compensation.

Read with Command 1025 (Read Thermocouple Configuration)

Written with Command 1031 (Write Temperature Manual Cold Junction Compensation)

Manual CJC Temperature Units
This selection only applies if the probe Type is a thermocouple and the Cold Junction Compensation
is "Fixed". Select the appropriate units for the compensation.

Read with Command 1025 (Read Thermocouple Configuration)

Written with Command 1031 (Write Temperature Manual Cold Junction Compensation)

Standard Type
There are two temperature standards "IPT - 68" and "IPT-90". Select the appropriate standard.
Note for most applications, the difference between these selections are not noticeable.

Read with Command 1024 (Read Temperature Probe)

Written with Command 1028 (Write Temperature Standard)
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ANNEX A. Revision History
A.1. Revision 1.0

Initial Revision.
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